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Introducing MacDrive 
This section contains general information about MacDrive for all users. 

See the Introducing MacDrive book to the left to explore all of the available topics. 

 
 

 

  

About MacDrive 6 
Many popular software packages exist in versions for both Windows and Mac OS, and are so 
similar in design and function that they are file-compatible. 

For example, a file created by Microsoft Excel for Macintosh can also be understood by Microsoft 
Excel for Windows. Even when using such "cross-platform " compatible software, however, a 
major and long-standing problem has been the lack of a straightforward way to transfer files 
between computers of different types. Mac and PC disks cannot normally be shared between the 
two types of computers, as each stores the documents you create on disks in different and 
incompatible ways. Normally, a disk formatted on one platform will not be recognized by the 
other. Modern Mac systems do include software that allows them to understand PC disks, but the 
results are not always desirable, and this does nothing to address the problems experienced by 
Windows users needing files from Mac disks. 

MacDrive addresses this problem in a very straightforward manner: it gives the Windows 
desktop, Explorer and any software running under Windows the ability to freely open and save 
files on Macintosh disks. 

With MacDrive, when you wish to use a Mac disk, you don't need to run any software—to open 
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or save files on a Mac-formatted disk, you just put it in and use it like any other disk. 

MacDrive can share all types of files between Macintosh and Windows, but it does not interpret 
or modify files. This means that you can share all types of files on Mac disks, but you need to 
have both Windows and Mac OS software that can understand the files you intend to share. 

MacDrive provides user-modifiable behaviors so that files created under Mac OS appear with 
appropriate file name extensions under Windows, and files created on Mac disks under Windows 
appear with appropriate icons under Mac OS. 

You can even format Mac disks, copy Mac disks, and both create and decode MacBinary files with 
convenient shortcut menu options. 

MacDrive opens a world of data-sharing possibilities: 

• Save your Windows spreadsheet to a colleague's Mac floppy in the middle of a cross-
country flight. 

• Mac-format a Zip disk and copy your publishing files to it before sending it off to the 
service bureau that is frequently confused or slowed-down by PC-formatted disks. 

• Configure your 3D animation software to render directly to a Mac-formatted external 
FireWire or USB disk, then transfer gigabytes of data between Windows and Mac OS in 
only the time it takes to carry the disk from one computer to the other. 

• Burn your newly-captured video clips to a Mac DVD for easy access on your Mac-based 
video editing workstation. 

• Insert clip art from a Mac CD-ROM directly into Microsoft Word. 

MacDrive is a powerful, fast, flexible, cost-effective and straightforward way to accommodate 
your Mac/PC file sharing needs. MacDrive is easy to install, works immediately, and quietly 
provides Windows with the power to access files on Mac disks from any software, at any time. 

 
 

 

  

System Requirements  
System requirements are modest. MacDrive requires Windows XP, 2000, Server 2003, 98SE or 
Me, and works with most types of disks. There are no special software or hardware 
requirements, although an appropriate interface adapter (USB, SCSI, FireWire, etc.) is required if 
you intend to share external drives between Windows and Mac OS by unplugging the drives from 
one computer and into the other.  

MacDrive can access Mac-formatted high-density (1.44MB) floppies (but not low-density 800KB 
floppies) in a standard 3½" PC floppy drive. You can also share removable media  such as Zip 
disks regardless of how the drive is interfaced with your Windows system (i.e. you can share a 
disk between a USB Zip drive on your Mac OS system and a built-in IDE Zip drive on your 
Windows system). 

 

MacDrive should not be installed on PC emulators such as Virtual PC (see Appendix A for 
details). 
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Registration  
It is important that you register MacDrive. Having your registration information on file allows us 
to keep you up-to-date on MacDrive improvements and let you know about special offers from 
Mediafour. Your registration also entitles you to free technical support, should you have any 
difficulties getting MacDrive to perform as expected on your system.  

You may register by mailing the registration card included in the MacDrive package, or by clicking 
MacDrive 6 > Register MacDrive in the Start menu. 

 
 

 

  

Technical Support  
If you are having trouble with MacDrive, the first place to look is the troubleshooting section of 
this User Guide. 

If you don't find the answer you're looking for there, visit mediafour.com/support/macdrive for 
your other support options. 

 

 

Because it is so immediate and covers so many topics, one of the very best and fastest 
ways to get assistance is online in the Mediafour Forums. The forums are so useful 
because the answer to your question may well already be there, and even if it isn't, there 
are typically hundreds of people participating, and someone is likely to be anxious to show 
off their knowledge by lending you a hand! 

  
 
 

 

A free MacDrive update that will eliminate whatever problem you are experiencing may 
be available; be certain to use MacDrive Update to check online for a newer version of 
MacDrive. 

   
If you don't find the answer to your question in any of those locations, you may need to contact 
Mediafour for assistance. 

Technical support is available only to registered MacDrive users, so it is very important that you 
register before contacting Mediafour. Click here for details on getting Technical Support for this 
version of MacDrive. 

When you contact Mediafour, please be prepared to provide the following information: 

• The serial number and version of MacDrive installed (see both in the Support 
Information window) 
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• The model and operating system of the computer on which MacDrive is being used 

• Expansion boards installed in the computer (SCSI adapter, USB, Ethernet, etc.) 

• All hard drives and removable cartridge drives installed in or attached to the computer 
(such as IDE 160GB internal hard drive, external USB Zip, external SCSI 2G Jaz, external 
FireWire 120GB, etc.) 

• The problem experienced, in as much detail as possible; essential details include the 
action being taken at the time the problem occurred, the expected results, the type of 
file being accessed, the software being used, the type of drive used, and the exact text 
of any error messages tha  appear. t

 
 

 

  

Software Updates  
Mediafour periodically releases minor free MacDrive updates, and also typically makes upgrades 
to the newest version of MacDrive available to registered MacDrive users at significant discount. 

News of updates, upgrades and enhancements are available on the Web at 
mediafour.com/macdrive, or better yet, through MacDrive Update.  

 
 

 

  

About This Guide 
MacDrive does what it does without requiring much attention or direct interaction. For many 
users, this Guide will be entirely unnecessary, as MacDrive begins silently doing its job as soon as 
it is installed. There are, however, many examples of special situations and features in this guide 
that may benefit you in your particular application. 

This guide is divided into four sections: 

• Introducing MacDrive 6, the section you are reading now. 

• Getting Started outlines the components of MacDrive and describes how MacDrive 
interacts with various hardware and software. 

• Reference explains exactly how to achieve particular results with MacDrive. 

• Appendices features valuable insights into the workings of MacDrive. 

Throughout the guide, links prefixed with a small boxed arrow indicate that they will take you to 
a destination outside of this User Guide, such as in the case of links like check for MacDrive 
Updates. 

Links followed by a small boxed question mark indicate that they will not take you anywhere, but 
will instead display a definition of the term, such as when cross-platform  computing is 
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mentioned. 

Sections or items labeled with or the larger version of this badge pertain to 
features that are only available under Windows XP, 2000 and Server 2003. 

 
 

 

  

Getting Started 
This section contains specific documentation for new MacDrive users. 

See the Getting Started book to the left to explore all of the available topics. 

 
 

 

  

Getting Started Window 
The Getting Started with MacDrive 6 window is a handy portal to many of MacDrive's most 
popular features. 
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You can get to Getting Started anytime by clicking MacDrive 6 > Get Started with 
MacDrive 6 in the Start menu. 

You can also open the Getting Started window by clicking the MacDrive notification icon and 
selecting Getting Started with MacDrive 6 from the pop-up menu, or by simply double-
clicking the notification icon. 

 

 

The Burn a Mac CD or DVD and Partition a Mac hard disk features are available only 

under Windows XP, 2000 and Server 2003.  

  

 
 

 

  

Using MacDrive 6 Immediately  
To start using Mac disks right away, do this:  

1. Put a Mac disk in any drive 

2. Access the drive from the desktop, Explorer or your favorite software 

You should have no problem accessing most types of disks right away. If you do experience 
problems, read on through the next three sections of the User Guide to learn more about 
MacDrive components and compatibility with various types of disks, drives and software. 

 

 

The Getting Started window is an excellent way to get to various popular MacDrive 
features quickly. 

  

 
 

 

  

MacDrive 6 Components  
Once installed, MacDrive is invisible and makes your Windows system ready to access Mac disks 
at any time. There are very few visible components of MacDrive, and those that exist are 
discreetly integrated into the Windows environment. The visible components of MacDrive include:  

• Getting Started with MacDrive 6 provides a friendly portal to the most popular 
MacDrive features. 

• MacDrive Disk Manager enables you to Mac-partition hard drives. 

 

• MacDrive CD/DVD Creator is a tool for creating Mac CDs and DVDs. 
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• General MacDrive behavior can be customized in MacDrive Properties. 

• The MacDrive Notification Icon indicates when Mac disks are discovered, and proves a 
shortcut menu with links to several MacDrive features. 

• Additional Mac-specific details about file and folders are found on the MacDrive tabs of 
the properties of files and folders on Mac disks, and also of the disks themselves. 

• Format Mac Disk and Copy Mac Disk options are added to the shortcut menus of 
most disks, as appropriate. 

• File-naming mode options are added to the shortcut menus of all Mac disks. 

 

• Show Mac Files and Show Windows Files options are added to the shortcut menus 
of dual-format CD-ROMs, and volume choices are added for multisession CD-Rs. 

• Extract Original Mac File(s) option is added to the shortcut menus of all files with 
".bin" or ".hqx" file name extensions. 

• Create MacBinary File(s) and View Mac Resources options are added to the 
shortcut menus of all files on Mac disks. 

• Small red apple overlays are added to the icons of drives containing Mac disks. 

 
 

 

  

Media Compatibility  
MacDrive enables the Windows desktop, Explorer and other software running under Windows to 
access nearly any type of Mac disk. Windows, however, must be able to communicate with the 
drive to allow MacDrive to function.  

If you are currently able to use your removable media  drive with normal PC-formatted disks, 
you can be confident that Windows is successfully communicating with the drive, and that 
MacDrive will be able to recognize Mac disks when they are inserted.  

If the disk device is new to your Windows system (as would be the case, for example, when 
plugging an external SCSI drive from a Mac OS system into your Windows PC FireWire adapter 
for the first time), it is likely that it will be recognized by Windows and work properly without 
requiring the installation of driver software from the drive or adapter manufacturer, but this is 
not guaranteed.  

When attaching a removable media drive, if Windows presents no drive letter for the removable 
drive, the hardware may not be properly installed, or driver software may be necessary. When 
attaching a Mac external hard drive, Windows will not present a drive letter unless both the drive 
and MacDrive are properly installed. If using SCSI or Fibre Channel drives, you can likely watch 
for notification from the SCSI or Fibre Channel adapter during the boot process detailing detected 
drives. If a newly-attached SCSI drive is not detected, check for ID conflicts and proper 
termination. Regardless of the drive type, if it is not detected, look for faulty cables, check both 
drive and adapter configuration, and try PC-formatted disks in order to confirm whether the drive 
is fundamentally working.  
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MacDrive works with high-density floppies, Zip, CD-ROM, CD-R/RW, DVD±RW/±R, Jaz, iPod, 
hard drives, SyQuest, MO, ORB and nearly any other disk device that works with Windows.  

High-density (1.44MB) Mac floppies can be accessed on any Windows system with a 3½" floppy 
drive. Low-density (400KB and 800KB) Mac floppies cannot be accessed due to physical 
differences between the floppy drives in Mac OS systems and Windows PCs.  

 
 

 

  

Software Compatibility  
MacDrive makes Mac disks appear and behave almost exactly like standard PC-formatted disks. 

MacDrive works well with Microsoft (Word, Excel, FrontPage, PowerPoint, Access, Works), 
AppleWorks, Adobe (Photoshop, Elements, Illustrator, InDesign, GoLive, Acrobat), Corel Painter, 
Macromedia (Director, Flash, Fireworks, Dreamweaver, FreeHand), QuarkXpress, FileMaker Pro, 
Avid (Media Composer, Symphony, Xpress), Digidesign Pro Tools, TransType, LightWave 3D, and 
countless additional applications. 

Classic Mac OS versions support file names up to 31 characters in length, and Mac OS X supports 
file names up to 255 characters in length. Because Windows supports file names of these 
lengths, there is rarely a need to shorten a Mac file name for compatibility's sake. MacDrive does 
occasionally have to present slightly altered filenames, however, as the Mac allows file names 
containing characters that are forbidden by Windows. In these cases, MacDrive substitutes 
characters as necessary to bring the displayed file name into compliance with Windows file 
naming rules. 

 

 

Please note that any time this guide refers to the substitution of characters in file names, 
it is the file names as they are presented under Windows that are altered—the names of 
Mac files as they exist on disk are never altered for the sake of compatibility, except when 
a Mac file is created or renamed from Windows. 

 
 
 

 

  

Reference 
This section contains specific documentation on a wide variety of MacDrive-related topics. 

See the Reference book to the left to explore all of the available topics. 
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MacDrive Properties 
This section contains topics specific to the MacDrive Properties interface. 

See the MacDrive Properties book to the left to explore all of the available topics. 

 
 

 

  

MacDrive Properties, MacDrive Tab  
To access MacDrive Properties, either click the MacDrive Notification Icon, if available, and 
choose MacDrive Properties, or alternately, click the Windows Start button, click Settings, and 
then click Control Panel. The Control Panel will be displayed—open MacDrive, and MacDrive 
Properties will be displayed.  

MacDrive Properties is divided into three tabs, each of which is accessible by clicking the 
appropriate tab: MacDrive, Options, and File Name Maps. 

To open MacDrive Properties to the MacDrive tab right now, click here. 

The MacDrive tab in MacDrive Properties provides the version of MacDrive currently installed, 
and a link to Getting Started with MacDrive 6. 
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MacDrive Properties, Options Tab  
To access MacDrive Properties, either click the MacDrive Notification Icon, if available, and 
choose MacDrive Properties, or alternately, click the Windows Start button, click Settings, and 
then click Control Panel. The Control Panel will be displayed—open MacDrive, and 
MacDrive Properties will be displayed.  

MacDrive Properties is divided into three tabs, each of which is accessible by clicking the 
appropriate tab: MacDrive, Options, and File Name Maps. 

To open MacDrive Properties to the Options tab right now, click here. 

The Options tab provides options and settings that are not often needed by most MacDrive 
users, and should be changed with great care.  
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The options that appear here will vary based on a wide variety of factors, including the 
version of MacDrive you are using, the version of Windows you are using, and other 
software that you may or may not have installed on your computer. Don't be concerned if 
your Options tab differs somewhat from the illustration above. 

Most advanced options are self-explanatory, especially given the tooltips that appear as your 
pointer hovers over each option, but some benefit from additional explanation, provided below.  

Dual-Format CDs/DVDs 
 This the global default for the setting discussed in the Multisession and Dual-Format 

Discs section. 

File Names 
 This the global default for the setting discussed in the File-Naming Modes section. 

General 
 The Remind me about MacDrive updates option controls whether or not MacDrive 

periodically offers to check for updates. 

 The Warn about volumes needing repair option controls whether or not MacDrive 
displays Volume Check warnings. 

 The Show MacDrive notification icon in taskbar option can be used to bring the 
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notification icon back if it has been hidden. 

Advanced 
 The Make all Mac disks read-only option prevents all modification of Mac disks, so it 

is good for computer forensics or other transfer of irreplaceable data. 

 The Disable MacDrive option provides a way to temporarily deactivate most of 
MacDrive without uninstalling it. 

 
 

 

  

MacDrive Properties, File Name Maps Tab  
To access MacDrive Properties, either click the MacDrive Notification Icon, if available, and 
choose MacDrive Properties, or alternately, click the Windows Start button, click Settings, and 
then click Control Panel. The Control Panel will be displayed—open MacDrive, and 
MacDrive Properties will be displayed. 

MacDrive Properties is divided into three tabs, each of which is accessible by clicking the 
appropriate tab: MacDrive, Options, and File Name Maps. 

To open MacDrive Properties to the File Name Maps tab right now, click here. 

The File Name Maps tab in MacDrive Properties is used to review and customize File Name 
Maps, which are rules that control how MacDrive handles file types, creators and extensions. 
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Adjustment of these settings is entirely optional, but there is quite a bit of power to be had here, 
and the settings are very easy to manage once you have familiarized yourself with them.  

File Name Maps enable you to modify and create associations between the Windows and 
Macintosh methods of identifying file contents. Windows uses file name extensions, while 
Macintosh uses two four-character codes called type and creator (see Appendix B). File Name 
Maps enable you to control when and how MacDrive appends file name extensions to the Mac file 
names it presents (based on the Mac type and creator properties stored with the Mac file), and 
when and how it sets the type and creator properties for newly made Mac files (based on the 
Windows file name extension of the file).  

Options Menu  
This menu in the upper-right of the File Name Maps tab provides options for managing both the 
display and contents of the File Name Maps list.  
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The View submenu controls whether the File Name Maps are displayed in the default List mode, 
which shows only the Map names, or in the Details view, which displays additional details about 
the Extension Maps in four columns labeled Name, Type, Creator and Ext, which is short for 
Extension.  

The Export and Import File Name Maps options can be used to transfer full sets of File Name 
Maps to and from files of your choosing, making it easy for one user to export a customized set 
of File Name Maps to be imported by other users.  

Restore Original File Name Maps simply resets all File Name Maps as if MacDrive had just 
been installed for the first time. No customized Maps are preserved.  

File Name Maps list  
Any File Name Map in the list can be reviewed or edited by either double-clicking the Map or by 
selecting it and then clicking Edit in the toolbar above the list. To add a Map, click the New 
button. To remove a Map, select it and click Delete. When Delete is clicked, you will be asked to 
confirm the deletion. To skip this confirmation, hold the SHIFT key while clicking Delete.  

To either determine which File Name Map affects the display of a given file's name, or to create a 
new Map for a given type of file if none already exists, simply drag and drop any file into the File 
Name Maps list.  

The first entry in the list of File Name Maps is called (default) and cannot be deleted or 
renamed. Any type, creator and file name extension specified in this File Name Map are used by 
default whenever more appropriate selections do not exist. Typically, there are no defaults 
specified, as they are likely to affect unintended files, but the changing of these defaults may be 
desirable for particular purposes.  

 
 

 

  

Edit File Name Map 
This window allows you to modify each File Name Map's Name, File type , File creator  and 
Windows file name extension .  It also provides checkboxes to indicate how you want these 
fields to be interpreted.  This window also allows drag-and-drop of files; dropping a file from a PC 
disk into this window will put that file's extension into the appropriate field, and dropping a file 
from a Mac disk into this window will put that file's type and creator into the appropriate fields. 
 Or, you can also use either of the Browse buttons to select a sample file. 
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Show this extension 
Selecting this option will cause MacDrive to append the file name extension that appears in this 
File Name Map whenever showing the name of a file that has this File Name Map's type and 
creator.  For example, an Adobe Photoshop image created under Mac OS and saved to a Mac-
formatted disk as North Lake would automatically appear under Windows as North Lake.psd, 
thereby allowing both Windows and the Windows version of Photoshop to recognize the file as a 
Photoshop document. 

Assign this type and creator 
Selecting this option will cause MacDrive to assign this File Name Map's type and creator 
whenever a file ending with the file name extension that appears here is created on a Mac disk, 
ensuring that the file will be displayed with the appropriate icon when the disk is used under Mac 
OS. 

Don't remove the extension 
Selecting this option will cause MacDrive to leave the file name extension as the file is created on 
a Mac disk.  This will result in the file name extension being present when the disk is used on a 
Macintosh, which is useful for files such as HTML documents, which may require file name 
extensions in order to be usable, even on a Mac.  For each File Name Map in which it is turn on, 
this option overrides the global Remove known extensions when creating Mac files option on the 
Advanced tab. 

 If you leave either the File type or File creator fields blank, it will act as a wildcard.  This is 
valuable in situations in which you want all files of a certain type or all files created by a certain 
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program to get the same file extension.  For example, a File Name Map with a type of TEXT, a 
blank creator and an extension of TXT will cause all Mac files with file types of TEXT to be 
displayed under Windows with file name extensions of .TXT, regardless of their file creators.  

 
 

 

  

MacDrive Warnings   
This section contains topics about various warnings that MacDrive may display. 

See the MacDrive Warnings book to the left to explore all of the available topics. 

 
 

 

  

Volume Check   
Whenever a disk is mounted , MacDrive checks the disk to see if it was properly and politely 
unmounted the last time it was used. 

If there are signs that it wasn't, MacDrive displays a warning like the example below, so that you 
will know there is a risk that the disk was corrupted when it was improperly unmounted. 

 

If MacDrive displays this warning, it does not mean that the disk has been judged to be corrupt; 
it merely means that there is a significant risk, and that the disk should either be repaired (using 
Mac OS tools) or reformatted in order to avoid future problems. 

 

 

This warning is significant, but if you'd like for MacDrive to stop displaying it, you can turn 
it off in MacDrive Properties, Options Tab. 
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Partition Conflict   
Whenever a disk is mounted , MacDrive checks the disk to see if it is properly and clearly either 
Mac-partitioned or using the PC partitioning  scheme. 

In some cases where disks have been repartitioned from Mac to PC, or vice-versa, a situation 
arises where invalid remnants of the old partitioning is left on the disk. In many of these cases, it 
is impossible for MacDrive to tell whether it is the Mac partitions or the PC partitions that should 
be considered valid. 

In such a case, MacDrive will display a warning like the sample below, and ask if you to choose if 
want to commit the disk to being Mac-partitioned or PC-partitioned, or if you don't know how to 
properly classify the disk. 

 

 

Be sure you know if the disk was last Mac- or PC-partitioned before making your choice! 
 If you are sure it was last Mac-partitioned, you should choose This is supposed to be a 
Mac disk. If you are sure it was last partitioned using Windows or other non-Mac 
software, you should choose This is supposed to be a PC disk. If you don't know 
which is correct, you can choose I don't know..., in which case you'll be asked again 
later. 

 
 

 

If you choose improperly, there is a way you can attempt to change your decision, but it 
is only likely to work if the disk hasn't been modified in any other way since initially 
making your choice.  In order to get this Window to appear again for all applicable disks, 
click Start > Run, and then type in the following (including the quotation marks): 
 
"%SystemDrive%\Program Files\Mediafour\MacDrive\MDDiskProtect.exe" 
/restore 
 
Mediafour technical suppor  cannot likely be of any assistance in the case that you t
improperly repair your disk. 
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Technical note: This tool judges a disk to contain PC partitioning if bytes 510-511 contain 
the hexadecimal signature 55aa, and judges a disk to contain Mac partitioning if bytes 
512-513 contain the ASCII signature "PM" or if bytes 1024-1025 contain the ASCII 
signature "BD" or "H+".  If a non-system disk is found to contain both PC and Mac 
signatures, the window above is displayed.  If a decision to repair the disk is made, the 
high bit of the undesired signature is turned on in order to invalidate the signature.  The 
disk is then remounted, and the invalidated signature is ignored by both Windows and 
MacDrive. 

  

 
 

 

  

Mac Disk Protection   
Whenever an attempt is made to change the partitioning  on Mac disk by any Windows software 
other than the MacDrive Disk Manager, MacDrive steps in to mediate the situation. 
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This is done because if Windows software other than MacDrive Disk Manager makes changes to 
the partitioning on a Mac disk, the disk will no longer be Mac-partitioned or Mac-formatted, and 
all contents of the Mac disk will be lost. 

Sometimes this is a desirable outcome, if a Mac disk is no longer needed, and you want to 
repartition and reformat it for use exclusively with Windows. In this case, you should select the 
Erase the Mac disk entirely option. 

At other times, however, MacDrive steps in and protects a Mac disk from accidental damage. In 
that case, you should choose the Do not change the Mac disk option. 

If you decide that you really do want to change partitions on the Mac disk, but want it to remain 
a Mac disk when you are done, you should choose the Modify Mac partitions option. 

 
 

 

  

Creating Mac CDs and DVDs   
MacDrive CD/DVD Creator is a simple but powerful disc authoring and burning application 

for the purpose of creating Mac-formatted CDs and DVDs. 

MacDrive CD/DVD Creator can be started by clicking the link above, by clicking MacDrive 6 
> Tools > Create a Mac CD or DVD in the Start menu, or from the Getting Started 
window. 
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MacDrive CD/DVD Creator can burn  CD-R/RW and DVD±RW/±R discs. 

The various controls in the window are fairly self-explanatory, but worthy of a bit of additional 
explanation: 

File list 
This list in the center of the window displays details about all files and folders prepared to be 
burned to a disc.  When you close and restart MacDrive CD/DVD Creator, the contents of 
this list will be remembered.  If you want to start over with an empty list, use the New 
button. 

New 
This button clears the file list of all files and folders. 

Add 
This drop-down allows you to add either individual files or whole folders at a time. You can 
also drag-and-drop files and folders into the file list. 

Delete 
This button deletes whatever items are currently selected in the file list. 

New Folder 
This button creates an empty folder inside of whatever container is currently selected in the 
file list. 

Drive list 
This drop-down list appears only if you have more than one drive on your system capable of 
burning discs. 

Eject 

Copyright © 2005 Mediafour Corporation. All rights reserved. 



This button ejects any disc in the current burning drive. 

Help 
This button takes you to this page. 

Burn Disc 
This button starts the disc writing process. 

The graphic and text in the lower-left corner of the window show how full the current burnable 
disc would be if burned at any point, and details about the type and capacity of the current 
burnable disc.  If no burnable disc is currently in the appropriate drive, then no useful 
information will be available here. 

 

 

If you have a drive capable of burning CDs and/or DVDs that isn't recognized by MacDrive 
CD/DVD Creator, please let us know online. 

  

 
 

 

  

Partitioning Mac Disks   
MacDrive Disk Manager is a wizard that gives you the ability to create and delete partitions 

on Mac-formatted hard drives. 
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The wizard-based interface makes the process simple and straightforward, but you should keep 
the following in mind: 

 While you can leave part of a disk unused (called Unallocated space by MacDrive Disk 
Manager), you will not then be able later make a PC partition  or volume  (FAT, 
FAT32, NTFS, or otherwise) in the unallocated space.  The only thing you can do with 
unallocated space is to make additional Mac partitions in it in the future, or simply leave 
it unused. 

 You cannot use MacDrive Disk Manager to add a Mac partition to a PC-partitioned disk. 
 Using MacDrive Disk Manager on a PC-partitioned disk will destroy all PC partitions. 

 You can't use MacDrive Disk Manager to resize a partition and retain the contents.  The 
only way to resize a partition is to delete and recreate it at a different size, which will 
result in the loss of any files in the original partition. 

 MacDrive Disk Manager works only with fixed hard drives; it cannot be used to partition 
removable disks. 

 
 

 

  

Format Mac Disk…  
The Format Mac Disk option appears under the MacDrive shortcut menu in the shortcut 
menus  of most disk icons. The window that appears when this option is chosen is very simple, 
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and similar in function to the standard Windows Format window.  

 

Be aware that while the Format type of Mac OS Extended (HFS+) is available for all disk 
types other than floppy disks, the resulting disk will only be compatible with MacDrive version 3.0 
and later, and with Mac OS 8.1 and later. The Mac OS Extended (HFS+) option provides more 
efficient use of disk space, especially when dealing with large disks and large numbers of files, 
but at the expense of compatibility. To ensure compatibility, Mac OS Standard (HFS) is 
recommended.  

If you want to reformat a Mac disk other than a floppy disk as a PC disk, you should first 
"unformat" the disk by selecting Unformat from the Format Type list. If you confirm that you 
wish to proceed, the disk will be unformatted, meaning that it will then be neither PC nor Mac-
formatted. The resulting disk can then reliably be reformatted as a PC disk using the standard 
Windows Format option.  

When using floppy disks, be aware that MacDrive works only with high-density (1.44MB) floppies, 
as PC floppy drives are physically incapable of reading or writing low-density (800KB or 400KB) 
Mac-formatted disks.  

 
 

 

  

Copy Mac Disk…  
The Copy Mac Disk option appears under the MacDrive shortcut menu in the shortcut 
menus  of floppy and removable disk icons. The interface that appears when this option is 
chosen is very simple and straightforward.  
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Copy Mac Disk creates a byte-for-byte exact copy of a given disk. A disk can be copied only to 
another disk of identical type and capacity.  

Only one drive is required, as the full contents of the disk being copied are stored on your system 
hard drive before being written to the destination disk. This does mean, however, that your 
system hard drive must have enough free space to temporarily hold the contents of a given disk. 
MacDrive will alert you if there is not enough free space available.  

After the disk being copied has been read, you will be prompted to insert the destination disk. If 
Number of copies is greater than one, you will then be prompted to insert additional 
destination disks, until all desired copies have been made.  

The Format destination disk(s) option is available only when copying floppy disks. If this 
option is selected, each destination floppy will be formatted before the disk is copied. This is 
typically necessary only when copying to new, unformatted floppy disks.  

 
 

 

  

Create MacBinary File(s)…  
A Create MacBinary File(s) option appears under the MacDrive shortcut menu in the in the 
shortcut menus  of all types of files on Mac disks.  
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A MacBinary file is a single file that contains both the data and resource forks of a Mac file, along 
with the original file name, icon and other Mac-specific properties.  

When Create MacBinary File(s) is clicked, you will be presented a folder browsing window so 
that you can select the folder into which the MacBinary files will be created. The MacBinary files 
are automatically named by appending a file name extension  of .bin to each of the original 
Mac file names.  

This option creates MacBinary III files, which are supported by older software designed for 
compatibility with MacBinary II files, as well as newer software specifically designed to take 
advantage of the additional information stored in MacBinary III files.  

See also Extract Original Mac File(s). 

 
 

 

  

Extract Original Mac File(s)…  
An Extract Original Mac File(s) option appears under the MacDrive shortcut menu in the 
shortcut menus  of files that are likely MacBinary  or BinHex  files. MacDrive makes this 
option available only for files with extensions of .bin or .hqx, so you will first need to rename a 
file if you are certain it is a MacBinary or BinHex file, but it does not have the appropriate 
extension.  
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When Extract Original Mac File(s) is clicked, you will be presented a folder browsing window 
so that you can select the folder into which the Mac files will be extracted. MacBinary and BinHex 
files contain the original Mac file names, so these names are used when extracting files.  

If you extract a Mac file to a non-Mac disk, you will be warned that some data will not be 
extracted. If you proceed, the result will be extraction of the Mac file's data fork, but no resource 
fork, icon, or other Mac-specific properties. This is typically generally not a problem when 
extracting documents.  

Extract Original Mac File(s) works with all BinHex files, and both MacBinary II and MacBinary 
III files. 

See also Create MacBinary File(s). 

 
 

 

  

MacDrive File Properties Tab  
When any disk, file or folder is selected, the Windows shortcut menu  offers a Properties 
option, which opens a tabbed window that provides detailed information about the selected 
objects. When you view properties for a Mac disk or a file or folder on a Mac disk, MacDrive adds 
a MacDrive tab to the properties display. Clicking the MacDrive tab reveals properties that are 
exclusive to Mac disks, files and folders.  

Below is an explanation of the properties that appear for files on Mac disks. The properties of 
disks and folders differ somewhat, but are generally similar.  
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Mac name  
Displays the file's true Mac name as it exists on disk. This may be different than the name 
reported by Windows due to the application of Extensions Maps and the necessity of changing 
some Macintosh file names slightly so that they don't violate any Windows file-naming rules.  

Data size  
Displays the size of the file's data fork , where cross-platform  data is usually stored.  

Resource size  
Displays the size of the file's resource fork , where additional data, usually Mac-specific, is 
stored.  

Backed up  
Displays the date that the file was last backed up, if ever.  

File type and File creator  
Displays the four-character codes stored by Mac OS that indicate the type of data contained in 
the file and the software that created the file. See both Appendix B and MacDrive Properties, File 
Name Maps Tab for details on how you can configure MacDrive to append extensions to the 
names of files on Mac disks based on type and creator attributes, as well as assign type and 
creator attributes based on the file name extensions of newly-made Mac files.  
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Advanced  
Click to open a window with additional advanced attributes of the disk, folder or file. Only the 
Name Locked attribute can ever be changed using MacDrive; the other attributes are shown only 
for your reference.  

 

Comments  
This field, which is not shown in the illustration of the main MacDrive properties tab, appears only 
when viewing properties of files and folders on Mac floppies, and only when the file or folder in 
question has comments associated with it.  

 
 

 

  

View Mac Resources…  
The View Mac Resources option appears under the MacDrive shortcut menu in the shortcut 
menus  of Mac files. This option is only available for files that contain resource fork data.  

The View Mac Resources option can be very valuable to developers and other users who are 
familiar with software such as ResEdit and have a need to extract Mac resource data under 
Windows.  
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View Mac Resources is very straightforward, and provides both a combination hexadecimal 
and ASCII display of the selected resource data and an option to save the selected resource data, 
whether an individual resource or the entire resource fork, as either a raw binary file or a 
hex/ASCII text file.  

The type of the selected resource is displayed, if known, but the contents are not interpreted (i.e. 
no icon display or audio sample playback).  

 
 

 

  

MacDrive in the Start Menu 
You can get to a variety of MacDrive features, documentation and assistance from the MacDrive 
6 folder in the Start menu. 

To get to the MacDrive 6 folder, do the following: 

• Click the Start button in the system taskbar (commonly at the bottom left of your 
screen) 

• Click Programs (if using Windows 98SE, Me or 2000), or All Programs (if using 
Windows XP or 2003 Server) 

In the pop-up list that appears, you should see the MacDrive 6 folder. 
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MacDrive Notification Icon  
The MacDrive notification icon appears in the taskbar notification area (sometimes called the 
"system tray") in the corner of your screen, near where the Windows clock is typically displayed. 
  

The MacDrive notification icon is entirely optional, so you may hide it at any time, but it does 
serve a couple of significant purposes, described below.   

 

Mac disk notification  
Whenever MacDrive discovers a new Mac disk, the notification icon flashes several times, 
alternating with an image of the icon of the drive in which the new Mac disk was discovered.   

MacDrive cannot flash the icon until the new disk is discovered by Windows, so when using 
different types of disks, the flashing will occur at different times.  For example, floppy disks are 
not discovered until the first attempt to access them.  In the case of most CD-ROM and 
removable media drives such as Zip drives, disks are discovered just moments after being 
inserted.  Hot-swappable USB and FireWire hard drives are typically discovered as soon as they 
are plugged into the appropriate port.   

Shortcut menu  
The MacDrive notification icon features a shortcut menu  that appears when the icon is clicked. 
 The menu provides shortcuts to Getting Started with MacDrive 6,  MacDrive Properties, and 
this User Guide. 

Getting Started with MacDrive 6 provides links to these items and more, and it is available in the 
Start menu at MacDrive 6 > Get Started with MacDrive 6, so if you decide to Hide this 
icon from the shortcut menu, you won't be losing access to anything that you can't access 
another way.  Hiding the notification icon does not otherwise change the behavior or capabilities 
of MacDrive.   

 
 

 

  

MacDrive Shortcut Menus  
MacDrive shortcut menus appear within the shortcut menus  of some files and all disks. The 
options available in each MacDrive shortcut menu vary with the type of files and disks selected: 

Copyright © 2005 Mediafour Corporation. All rights reserved. 



 The shortcut menus of files on Mac disks and all files with .bin or .hqx file name 
extensions contain MacBinary and BinHex options. 

 The shortcut menus of certain types of CD-ROMs include options for handling 
multisession and dual-format discs. 

 The shortcut menus of all Mac disks include options for adjusting the file naming mode. 

 
 

 

  

Multisession and Dual-Format Discs 
MacDrive shortcut menus appear within the shortcut menus  of some files and all disks. The 
options available in each MacDrive shortcut menu vary with the type of files and disks selected. 

Multisession Mac CD-R shortcut menus 
A list of the names of available volumes appears in the disc shortcut menus of multisession CD-
Rs . Selecting a new volume causes the current volume to disappear, and the new volume to 
appear in its place. The effect is much like ejecting one disc and inserting another. MacDrive will 
remember which session you last used on a particular disc, and will return you to that session if 
that disc is used again.  

  

Dual-format Mac CD-ROM shortcut menus 
Some CD-ROMs have both Windows (ISO-9660) and Mac (HFS or HFS+) volumes on them. 
MacDrive enables you to easily choose which set of files you'd like to access from the disc 
shortcut menu. As with multisession discs above, the effect is much like ejecting one disc and 
inserting another. MacDrive will remember which volume, Windows or Mac, you last used on a 
particular disc, and will return you to that set if that disc is used again.  
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On some computers, after choosing a new volume on a multisession CD-R or a new file 
set on a dual-format CD-ROM, the name of the disk as it appears under Windows Explorer 
may not be properly updated. Therefore, if there is any doubt, you should look at the 
contents of the disk and the MacDrive shortcut menu, rather than the name of the disk, to 
assure that the desired volume is available.  

 
 
 

 

  

File-Naming Modes   
MacDrive shortcut menus appear within the shortcut menus  of some files and all disks. The 
options available in each MacDrive shortcut menu vary with the type of files and disks selected. 

A Mac disk can be set to one of three file file-naming modes, each of which affects the display of 
the names of all files on that disk differently: 
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Normal Use 
Appropriate for normal day-to-day usage; this mode maximizes compatibility with a wide 
range of software, and preserves international characters where possible. File name 
extensions are handled as generally represented by this User Guide. This is the default 
setting. 

International Use 
Appropriate for a disk containing files named using international Unicode characters, in cases 
where preservation of those characters is important, but compatibility with a wide range of 
software is less important. File name extensions are handled as generally represented by this 
User Guide. 

Backup/File Transfer 
Appropriate for tape backups of Mac disks, or transfers of files from one Mac disk to another, 
including between a true Mac disk and an NTFS volume storing a Services for Macintosh  
network share. This mode does an excellent job of preserving Unicode characters, but, unlike 
the other two modes above, does not append artificial file name extensions for software-
compatibility purposes. 

Individual Mac disks can be in different file-naming modes concurrently.  MacDrive will remember 
what mode was last assigned to a particular disk, and will automatically maintain that mode 
whenever that disk is used again in the future. 

 
 

 

  

Appendices 
This section contains additional documentation on a few specific MacDrive-related topics. 

See the Appendices book to the left to explore all of the available topics. 

 
 

 

  

Appendix A: Troubleshooting  
Why doesn't this floppy disk work? 
A floppy disk may not be recognized by MacDrive because it is corrupted or damaged, because it 
is not actually a Macintosh-formatted disk, or because it is a low-density floppy. You can verify 
that a disk is high-density by ensuring that there is a rectangular hole in the upper-left corner of 
the disk, opposite the sliding write-protect tab in the upper-right. You can be certain that a disk 
is Mac-formatted and undamaged by attempting to use the disk under Mac OS. If the disk's 
behavior is unusual even on the Macintosh, Mediafour recommends Symantec Norton Utilities for 
Macintosh as an excellent tool for diagnosing Macintosh disk problems of all kinds.  

Why can't I open my Macintosh files? 
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MacDrive is not a file translator. You must have software on your Windows system that is capable 
of understanding the Mac files that you intend to share. Many software packages (such as 
Microsoft Word) exist in versions for both Windows and Mac OS— documents and data files 
created by such software are easily shared. Audio and image files are often stored in formats that 
are not associated exclusively with a particular operating system (such as MP3, JPEG and GIF)— 
such files can generally be shared very readily. Your ability to share other data, such as 
databases, depends on the capabilities of the software that you have installed on both the Mac 
and PC.  

Why can't I run my Macintosh game, word processor, or other software? 
MacDrive is not a Mac OS emulator, so it can't make Windows run your Macintosh software. 
MacDrive is for sharing cross-platform  documents and data files. If you intend to use data from 
one platform on the other, you must have software on both systems that can deal with the data 
in question— for example, MacDrive can share Adobe Photoshop documents between Macintosh 
and Windows systems, but you must have Photoshop or other compatible software on both 
systems in order to accomplish this.  

Why don't I see the icons or file name extensions that I expect? 
The Extension Maps tab of MacDrive Properties provides a simple interface for editing the rules 
that determine what icons Mac OS will display when Windows creates a file on a Mac-formatted 
disk and what file name extensions Windows will display for files on Mac-formatted disks. See 
both Appendix B and MacDrive Properties, File Name Maps Tab for details on the relationships 
between Windows file name extensions  and Mac OS type  and creator codes .  

Why are there unexpected characters in some file names? 
The Macintosh and Windows character sets are different— every provision has been made to 
properly translate international and symbol characters properly between the two operating 
systems, but both operating systems utilize characters that are unavailable on the other. This 
affects the appearance of some file names under Windows, but the files are accessible and will 
continue to look correct under Mac OS. 

Why can't I delete certain folders, even though they are empty? 
The folder most likely only appears to be empty. A folder may contain critical Macintosh system 
files that are intentionally inaccessible through MacDrive. Another possibility is that Windows may 
be configured not to show hidden files, and these unseen files may simply be hidden.  

Why does my Windows disk maintenance software dislike my Mac disk? 
 

 

Beware of this situation— if Windows disk defragmentation, maintenance or recovery 
software (such as Symantec Norton Utilities for Windows) accesses a Macintosh disk, it 
won't know what to do with it, and will likely want to "fix" it by trying to coerce it into 
being a PC disk. 

This will not work, and will definitely cause loss of some or all of the data on the disk. It 
must never be attempted. 

Why does Norton Utilities for the Macintosh complain about bad file dates? 
Symantec Norton Utilities for the Macintosh is very thorough and reliable. It is so thorough, in 
fact, that if the PC clock is set significantly later than the Mac OS clock, and you use MacDrive to 
write to a Mac format disk, Norton Utilities for the Macintosh will see files on that disk that 
appear to have been made in the "future", and warn you that something has gone wrong. You 
needn't worry about this warning— the "future" file dates will not cause any problem, but you are 
welcome to allow Norton Utilities to correct them, if you like.  
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I thought that this was a Mac CD-ROM—why am I seeing short file names? 
Some CD-ROMs have both Macintosh and PC volumes. Normally, when presented with such a 
dual-format CD-ROM, MacDrive will ignore the Macintosh (HFS or HFS+) volume, and allow the 
PC (ISO-9660) volume to be made accessible. You can choose to access the Mac volume, 
instead, by selecting it in the disc's MacDrive shortcut menu.  

I made some changes in MacDrive Properties—where did my files go? 
To update file listings on the desktop or in Windows Explorer, you may need to select Refresh 
from the View menu or press the F5 key. The methods for refreshing file listings in other 
software vary, but choosing a different folder and then returning to the original folder will usually 
accomplish this.  

Why am I having problems using MacDrive with a PC emulator on my Mac? 
 

 

Use MacDrive with a Mac-based PC emulator (such as Virtual PC or RealPC) only at your 
own risk. 

This is not a supported or approved way to use MacDrive, as both MacDrive and Mac OS 
will be unaware of one another, and will battle for control of Macintosh disks. This can 
result in corrupted files and disks, and should generally be avoided. 

The dangers are minimized if you are only reading files, and never writing, but even then 
your data is at risk. 

Why am I seeing a 'Mac disks are not accessible because critical MacDrive 
components are not available' message? 
If any of the file or settings associated with MacDrive become corrupted for any reason, you may 
see this message. If you do, it is recommended that you reinstall MacDrive, after making sure
that you have your original MacDrive installation disc o  know the location of your downloaded 
installation file.  To uninstall MacDrive, click Start > Control Panel > Add or Remove 
Programs, then select MacDrive from the list and click the Remove button. After MacDrive has 
been uninstalled, restart your system and reinstall MacDrive. If, after then restarting one last 
time, MacDrive hasn't been restored to working order, you should seek technical support. 

 
r

 
 

 

  

Appendix B: Extensions, Types and Creators  
Under Windows, long file names typically end with a period followed by a "file name extension" 
of one or more characters (typically three, and rarely more than six) that indicates both to 
Windows and to the user the type of data that is stored in a given file. Windows uses this 
extension to decide what type of icon to display for a file and how to handle user input such as 
the double-clicking of a file icon. This extension is very significant, as Windows generally 
considers it the sole indicator of a file's contents. 

Classic Mac OS versions handle identification of a file's content very differently. With each file, 
the Macintosh stores two four-character fields called the "type" and "creator" fields. These fields 
are not part of the file name, and are typically invisible to the user. The contents of these fields 
indicate to Mac OS the type of data in the file and the software that created the file, respectively. 
The Macintosh decides how to handle user input such as the double-clicking of a file solely by 
interpreting the type and creator for the file, and therefore has no need for file name extensions, 
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so they are not frequently used in Mac filenames. 

Mac OS X complicates the issue somewhat, as Mac OS X supports both file name extensions and 
type/creator pairs, so you may see files from Mac OS X systems with file name extensions, but no 
type and creator, or vice-versa, or with both type/creator pairs and file name extensions. 

MacDrive provides a powerful mechanism for making these two very different file identification 
methods work together. File Name Maps are user-modifiable rules that tell MacDrive when and 
how to append a file name extension based on a file's type and creator pair, and conversely, 
when to assign type and creator codes based on the file name extension of a newly-made or 
newly-renamed file. 

This means, for example, that a Microsoft Word for Macintosh document named Letter to Steve 
can automatically appear as Letter to Steve.doc under Windows, and a Windows bitmap image 
saved to a Mac disk as Logo.jpg could automatically be assigned an appropriate type and 
creator so that the file will be recognized as a JPEG image called simply Logo under Mac OS. 

File Name Maps are arguably the most powerful feature of MacDrive— depending on your 
specific use for MacDrive, you may not need to customize them, but it is valuable to be familiar 
with the possibilities that they offer. 

 
 

 

  

Appendix C: Additional Features   
Additional Explorer Column Settings  
This feature expands the options for display of columns in Windows Explorer, and is available 
only under Windows XP and 2000. The additional options are available from Explorer's Choose 
Details or Column Settings window, which is available by selecting Choose Details in the 
View menu under Windows XP, or by selecting Choose Columns in the View menu under 
Windows 2000.  

Copyright © 2005 Mediafour Corporation. All rights reserved. 



 

The four options are Mac Resources, Mac Type, Mac Creator and Mac Backup Date. Each 
adds the selected information in a separate column in Windows Explorer. This allows you to see 
Mac-specific information without viewing the properties of each file individually.  

 
 

Glossary 
BinHex 
BinHex is a file format used to store and transfer Mac files on non-Mac disks and computers.  BinHex is a very popular 
format for Mac files available on the Internet.  A BinHex file contains the original Mac file's name, icon, system bits, dates, 
file type, file creator, data fork and resource fork.  MacDrive does not create BinHex files, but it will extract Mac files from 
existing BinHex files. 

Burn 
In the case of creation of CD-R/RW or DVD±RW/±R discs, to burn a disc is to write data to the disc. Burning refers to the 
act of a laser modifying the surface of the disc to represent the data being written. 

Cross-platform 
Anything that is intended for use with multiple operating systems.  Many popular types of data files are regularly used 
with multiple operating systems, such as MP3 audio files and JPEG image files.  Some software packages are also 
considered to be cross-platform, meaning that functionally equivalent implementations of the same software package are 
available for multiple operating systems, and that the various implementations can use the same data files.  MacDrive 
does an excellent job of helping these types of software packages share their documents and data files between Mac OS 
and Windows. 

Data fork 
Each Macintosh file has two components called "forks" (see also Resource fork, below).  The data fork is the primary 
fork— data that is useful when shared between Macintosh and Windows is usually stored here.  When MacDrive shows a 
listing of files on a Mac disk, it always displays the data forks. 
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File Creator 
A property of a Mac file that consists of a four character code indicating the software that created the file.  This 
information is not normally available when using a Mac, but MacDrive makes the information available from the 
MacDrive tab of a file's properties window. 

File name extension 
Under Windows, file names frequently end with a period and a two- or three-character "file name extension" that 
indicates both to Windows and to the user the type of data that is stored in a given file.  Windows uses this extension to 
decide what type of icon to display for a file and how to handle user input such as double-click.  This extension is very 
significant, as it is Windows' primary indicator of a file's contents. 

File Type 
A property of a Mac file that consists of a four character code indicating the nature of the data stored in the file.  This 
information is not normally available when using a Mac, but MacDrive makes the information available from the 
MacDrive tab of a file's properties window. 

Long file name 
This is any name that violates the limitations of a short name.  Windows Desktop, Explorer and most Windows software 
packages display long names when displaying file listings. 

MacBinary 
MacBinary is a file format used to store and transfer Mac files on non-Mac disks and computers.  A MacBinary file contains 
the original Mac file's name, icon, system bits, dates, file type, file creator, data fork and resource fork.  MacDrive will 
both extract Mac files from MacBinary files and create MacBinary files from files on Mac-formatted disks. 

Mount 
To make a volume (see Volume below) accessible.  When a removable disk is inserted in a drive, or a hot-swappable 
drive is plugged in, Windows will scan the disk for partitions (see Partition below) containing volumes.  Each volume 
found is then mounted, meaning that it will be given a drive letter and made accessible to the user. 

Multisession CD-R 
A multisession CD-R is a disc which has not been created all at once, but instead has had files added during two or more 
"sessions."  Effectively, such a disc contains multiple distinct volumes. 

Partition 
An area of a disk designated to remain isolated from other partitions on the same disk, and typically intended to contain a 
volume (see Volume below). 

Removable media 
Any type of storage device which allows removal of the physical storage medium (the "disk" or "cartridge").  Examples of 
this type of device include Zip, Jaz, SyQuest, optical, and ORB. 

Resource fork 
This is the secondary component of a Macintosh file (see also Data fork, above).  Information about a file's Resource 
Fork is available in the MacDrive File Properties tab. 

Short file name 
A short name is also known as a DOS-style or eight-dot-three (8.3) file name.  Older 16-bit (Windows 3.x) software will 
most likely support only short names, which are limited to a maximum of eight characters followed by a period and three 
more characters.  Furthermore, the characters must be uppercase and are limited to letters, digits, and a few select 
punctuation symbols— even spaces are forbidden. 

Shortcut menu 
Windows software frequently makes functions and options available via pop-up menus that appear when the alternate 
(usually right) mouse button is pressed.  The menus are also sometimes called "context menus" because they are 
context-sensitive— the contents of the menu depend on what the mouse pointer is pointing at when the alternate mouse 
button is pressed.  For example, the shortcut menu of an item in a scrolling list might provide options that affect only the 
selected item, while the shortcut menu of the list itself (not pointing at any particular item) might provide options that 
affect the appearance or behavior of the list itself. 

Services for Macintosh 
Services for Macintosh is standard Microsoft software on Windows XP-, 2000- and NT-based servers which enables 
Windows to act as a file server for Mac OS-based network clients. 

On such a Windows system, when the Show Windows-compatible file names advanced option is turned off, Mac OS 
file names are made acceptable to Windows by substituting legal Unicode characters for illegal Mac characters, much as is 
done by Services for Macintosh in order to preserve the exact names of files saved to NTFS disks by Mac clients.  Because 
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MacDrive does this and also represents resource forks and file headers as file streams, while this advanced setting is 
turned off, every file copied between an actual Mac disk and an NTFS volume hosting a virtual Macintosh network volume 
will retain its exact name, Finder flags, custom icon and resource fork. 

It should be noted, however, that a great deal of Windows software does not deal well with file names containing these 
Unicode characters.  In addition, this setting overrides all file name extension appending and removal, so this setting 
should be off only when your goal is to transfer files between disks, and not when you are opening and saving documents 
and data files. 

Unmount 
To politely eliminate all access to a volume (see Volume below) that was previously accessible. 

Volume 
An organizational and storage system for files that either occupies a whole disk, or occupies a partition, in the case that a 
disk is partitioned (see Partition above).  When a set of files is accessed through a drive letter, it is a volume that is 
being accessed. 
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